eSync - CMS
Remote Access Application

Operating Instructions & User's Guide
1. Remote Management Software ............................................................... 3

1-1. Introduction ............................................................................................... 3

Overview ........................................................................................................... 3

Feature .............................................................................................................. 3

System recommendation .................................................................................. 3

1-2. Installing Software .................................................................................... 4

1-3. Starting the Remote Management Program ................................................. 5

1-4 Real-Time Monitoring ................................................................................ 8

1-5. User & User Group Administrator ............................................................... 22

1-6. Automatic Connection and Address Book Administration ....................... 24

1-7. Real Time Monitoring the Address Book Site Administration .................. 25

1-8. Screen Layout Function .......................................................................... 26

1-9. DVR Information Setting ........................................................................... 28

1-10. Environments Setup ................................................................................. 32

1-11. Video Image Capture .............................................................................. 36

1-12. Adjusting Colors .................................................................................... 38

1-13. Full screen mode ..................................................................................... 39

1-14. Record Search ........................................................................................ 40

1-15. Playback ................................................................................................ 42

1-16. Local Player ............................................................................................ 45

1-17. Remote Control setting .......................................................................... 47
1. Remote Management Software

1-1. Introduction

Overview
The eSync-CMS is designed to manage the DVR through the network at a distance. The eSync-CMS supports the remote management for the DVR of the following models.
eSync - 1648e / 824e / 424e
You can use the following functions using the remote management software.

Remote real-time image monitoring
Remote search and playback of recorded images
Smart Search and playback of images stored in the user computer
System setting for the remote DVR
Calculation of time available to record depending on the hard disk space
Transform the MPEG-4 format download and recorded files to MPEG-1 format files
System upgrade
Other functions

Feature
CMS can list up to 4,096 DVR units.
Remote search and playback of recorded images
Smart Search and playback of images stored in the user computer
System setting for the remote DVR
Calculation of time available to record depending on the hard disk space
Up to 32 users can connects to one DVR at the same time
Image data transmission at up to 120 fps at 16 channel view.
Real time monitoring, record, and full screen playback function
Monitoring using Drag & Drop by channel
Zoom In and Zoom Out on real time video
Image and voice backup by network download
Replay and smart search function of Backup PC file
Backup of recorded images using the download
Search and playback of backup local files
Modifies, edits, saves and applies settings such as record/schedule/NTP/network of the DVR
User-friendly Graphic User Interface (GUI)

System recommendation
Software
* Direct X 9.0 or higher
* Internet Explorer 6.0 or higher

Hardware
* CPU: Intel Pentium 512 43.0 GHz
* RAM: More than 512 MB (DDR)
* Video Card: - NVIDIA FX chipset-based More than 128MB
  - ATI Radeon 9000 Series, x3000 Series
  - Video memory of more than 64MB
    Product supporting the YUV Format and Overlay
* HDD: More than 20GB
1-2. Installing Software

1. Insert the remote management software CD provided with the product into the CD drive.
2. Click the Setup.exe file.
3. Select an installation language and click the [OK].
4. Continue to install following the screen guide.
1-3. Starting the Remote Management Program

1. Click the Start > Programs > eSync-Client Software > eSync-Client > eSync-Client Software.
2. When the user login window appears, enter the administrator password to run the program.
   **(Default administrator password: 1111111)**

3. When the program is run, the following GUI screen is displayed.

**Graphic User Interface (GUI)**

<table>
<thead>
<tr>
<th>Function mode selection tabs</th>
</tr>
</thead>
<tbody>
<tr>
<td>Live Mode</td>
</tr>
<tr>
<td>Search</td>
</tr>
<tr>
<td>Local Player</td>
</tr>
<tr>
<td>DVR Setup</td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td>Remote real-time monitoring</td>
</tr>
<tr>
<td>Remote search and playback of recorded images</td>
</tr>
<tr>
<td>Search and playback of images stored in the user computer</td>
</tr>
<tr>
<td>System setting for the remote DVR</td>
</tr>
<tr>
<td><strong>Window control and program exit buttons</strong></td>
</tr>
<tr>
<td>--------------------------------------------</td>
</tr>
<tr>
<td><img src="image" alt="Version information" /></td>
</tr>
<tr>
<td><img src="image" alt="Window minimization" /></td>
</tr>
<tr>
<td><img src="image" alt="Window maximization" /></td>
</tr>
<tr>
<td><img src="image" alt="Program exit" /></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th><strong>Function buttons</strong></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Environment setting" /></td>
<td>Environment setting</td>
</tr>
<tr>
<td><img src="image" alt="Address Book" /></td>
<td>Address Book</td>
</tr>
<tr>
<td><img src="image" alt="Image Captures" /></td>
<td>Image Captures</td>
</tr>
<tr>
<td><img src="image" alt="Image Print" /></td>
<td>Image Print</td>
</tr>
<tr>
<td><img src="image" alt="Controls of Image colors" /></td>
<td>Controls of Image colors</td>
</tr>
<tr>
<td><img src="image" alt="Screen Record" /></td>
<td>Screen Record</td>
</tr>
<tr>
<td><img src="image" alt="User Group Control" /></td>
<td>User Group Control</td>
</tr>
<tr>
<td><img src="image" alt="1-channel divided screen mode" /></td>
<td>1-channel divided screen mode</td>
</tr>
<tr>
<td><img src="image" alt="4-channel divided screen mode" /></td>
<td>4-channel divided screen mode</td>
</tr>
<tr>
<td><img src="image" alt="16 / 25 / 36 / 49 / 64 channel divided screen mode" /></td>
<td>16 / 25 / 36 / 49 / 64 channel divided screen mode</td>
</tr>
<tr>
<td><img src="image" alt="Real time screen rotation function" /></td>
<td>Real time screen rotation function</td>
</tr>
<tr>
<td><img src="image" alt="User screen setting addition" /></td>
<td>User screen setting addition</td>
</tr>
<tr>
<td><img src="image" alt="Full screen mode chosen from a user screen setting" /></td>
<td>Full screen mode chosen from a user screen setting</td>
</tr>
<tr>
<td><img src="image" alt="Full screen mode" /></td>
<td>Full screen mode</td>
</tr>
</tbody>
</table>
Playback Control Button

This button is used for the playback.
Forward Play / Reverse Play
Forward Single Frame Play / Reverse Single Frame Play
Fast Forward / Fast Rewind
- The speed control for the normal play ranges from 1/16X to 16X in 1-ch mode. (Units 1/16X, 1/8X, 1/4X, 1/2X, 1X, 2X, 4X, 8X, 16X)
- The speed control for the fast play ranges from 30X to 300X in 1-ch mode. (Units 30X, 60X, 90X, 120X…270X, 300X)
- The speed control for the single play ranges from 1X to 30X in 1-ch mode. (Units 1, 2, 3, 4, 5, …, 28, 29, 30x)

PTZ Control Button

Button for controlling Pan/Tilt
- Button for use in each adjustment mode
PAN: Left/Right
TILT: Up/Down

Date & Network Transmission Information

Displays the current PC date and time and total network transmission volume
1-4 Real-Time Monitoring

Viewing real-time images
Choose a DVR icon in the connection list on the right. Drag and drop it in the Live Mode display area. The screens will appear in sequence.

After screen connection, all channels of the DVR will appear on the Live Mode display area.

DVR camera unit view
Double click on the location. Drag and drop the channel number into the Live Mode display area.
To stop pictures by a camera unit, drag and drop the channels outside the Live Mode display area.

Divided channel screen view
After the picture of channels appears on the program screen monitor, click the divided mode button at the display mode button, then you can view the divided screen.

1 Channel segmentation mode
4 Channel segmentation mode

9 Channel segmentation mode

16 Channel segmentation mode
25 Channel segmentation mode

36 Channel segmentation mode

49 Channel segmentation mode
64 Channel segmentation mode
**Video Rotation function**

Choose the rotation button to open the Live Video Rotation window and set the Screen unit Rotation mode and duration time.

![Live Video Rotation dialog box](image)

The screen will rotate according to the chosen channel mode and time. If you want to stop the rotation, click the rotation button.
**DVR unit rotation**
Choose the rotation button to open the Live Video Rotation window and set the DVR Site Rotation mode and duration time.

When a rotation starts, the chosen DVR cameras will rotate while changing their channel modes. If there are 4 cameras in a DVR, it will rotate in 4 channel modes. If you want to stop the rotation, choose the rotation R button again.
Screen magnification / Contraction function
An alternate menu will appear when right clicking on the mouse in one channel view. Magnification and contraction ranges from 100 % - 1600 %. (100, 150, 200, 300, 500, 700, 1000, 1600 %)

A PIP screen will be shown on the right bottom of the screen. The magnified picture appears in the red box. To move the magnified picture, move the red box in the PIP screen to a place you want to magnify.

You can magnify or contract the image by pressing the CTRL key and the scroll up and down mouse wheel simultaneously within the PIP screen.
Controlling the PTZ
Select the PTZ camera displayed on the screen as shown in the figure below

Adjusting the Pan / Tilt
Select the channel where the PTZ is connected and use the arrow buttons to adjust the Pan/Tilt

Adjusting Zoom in/ Zoom out
After selecting the channel where a PTZ camera is connected, adjust by clicking the Wide/Tele button controlling Zoom in the PTZ control group.
Adjusting the Focus
After selecting the channel where a PTZ camera is connected, adjust by clicking the Near/Far controlling the Focus in the PTZ control group.

Controlling the Preset
After selecting the channel where a PTZ camera is connected, the PTZ Preset position and number can be set up and moved using the Move/Register button in the PTZ Preset group.

Adjusting the Speed
After selecting the channel where a PTZ camera is connected, speed can be controlled using the PTZ speed slide bar in the PTZ control group.
Controlling the Tour
After selecting the channel where a PTZ camera is connected, Select Tour 1 or Tour 2 to run PTZ.

Controlling the Two way Audio
The Two-way Audio function will play the voice data that was input using a microphone or an audio input device by the user in eSync-CMS and sent to the DVR, in the DVR system

Selecting a DVR in the connected DVR list

Pressing the Talk button and inputting speech
Pressing the Talk button again disabling the feature

After 2 minutes, the Two-way Audio function will be stopped automatically.

If another user uses the Two-way Audio function first, the following message will be displayed. This function can be used when that user is done.

If the Playback mode is being used in the DVR system, the following message will be displayed. The DVR may be used when the Playback mode has ended.

While the Two-way Audio function is being used, if the Playback mode is used in the DVR system, the following message will be displayed and the Two-way Audio function will be stopped.
Controlling the Relay Out
The Relay Out function will turn On/Off the devices connected to Relay Out. The number of Relay Out supported is different for each model. (eSync series/SSA-1648e, SSA-824e, SSA-424e).

Selecting a DVR from the connected DVR list

Indicating the Relay Out state for the DVR system

Using the Start button to set up On/Off for Relay Out
Controlling the audio

If the audio record is set, you can listen to the audio set to each channel in real-time as in the following figure.

Executing live monitoring by selecting the DVR icon or the camera icon causes the channels where audio is connected to display an audio icon on the lower right part. Playback will then be carried out automatically starting with the audio connected to channels with lower playback order number.

To change the audio channel, click the channel displaying the icon. The icon will then change to and the audio for the corresponding channel will be played.

Drag the button to control the audio volume.

Selecting the button activates the noise cancellation. To terminate the noise cancellation, select the button again or move the volume adjustment bar.
1-5. User & User Group Administrator

Add Group
Click [Add] button to add User group.

Edit Group
Click [Edit] button to edit User & User Group Manager as shown in the figure below.

Delete Group
Click [Remove] button to delete User Group as shown in the figure below.

Group Properties
Click [Properties] button for the user group property.
User Add
Click [Add] button for the add User
Enter the User Name, Password, Full name, Description, E-Mail.

User Edit
Click [Edit] button to edit User Group as shown in the figure below.
Edit User Name, Description and User Group as shown in the figure below.

User Delete
Click [Remove] button to delete User Group as shown in the figure below.

User Properties
Click [Properties] button for the user group property.
1-6. Automatic Connection and Address Book Administration

Automatic Connection Function
For automatic connection registration, check the desired DVR connections.

To cancel the automatic connection, uncheck the desired connections.
1-7. Real Time Monitoring the Address Book Site Administration

Add an address
Press the [Add] button to add a new entry.

Modify the address book
Press the [Modify] button to edit the entry.

Delete the address site
Press the [Delete] button to remove the entry.
1-8. Screen Layout Function

Screen Layout Administration

Press the [Add] button to create a new layout.

Enter a name, description and a channel mode.

Edit Screen Layout

Press the [Edit] button to modify an existing layout.

Remove Screen Layout

Press the [Remove] button to delete a layout.
Apply Screen Layout
Choose the screen layout from the right bottom screen layout list in the live mode, and then click the S button. When you choose a screen layout from the screen layout list, there appears a customized live screen as below.

When you start a program, you can set the customized screen layout to be operated automatically. If the user chooses the screen layout he wants from the live screen layout as below, the program starts with the chosen screen layout.
1-9. DVR Information Setting

Product Information
Select the DVR site name and click the right mouse button. Select the Product Information on the popup menu.

Product Information Window

1. S/W version (Build Number)
2. H/W version (Model Name)
3. Video Mode
4. HDD Information
   - Total Capacity
   - Used Size
   - Free Space
   - Start Date
   - End Date
5. Network Setting
6. Overwrite On/Off
Bandwidth Limitation Function
Select the DVR site name and click the right mouse button. Select the Bandwidth Limitation on the popup menu.

Bandwidth Limitation Window

Image resolution
It regulates the screen resolution. The lower the resolution, the faster the transmission speed. (CIF > Field > Full)

Image quality
It regulates screen quality. High image Quality lowers compressibility and decreases speed. Poor image quality increases compressibility and speed

Image transmission speed
Screen transmission frame numbers are regulated. On the basis of 3 D frame, the following values are approximately set.

High: 30, Medium: 15 Low: 7.5
Network Account Management Function
Select the DVR site name and click the right mouse button. Select the Network Account option on the popup menu.

Add Network Account
Press the [Add] button and set user name, access code, and DVR authority and press the [OK] button.

Modify Network Accounts
Press the [Modify] button to revise user name, access code, and DVR authority and press the [OK] button.

Delete Network Accounts
Press the [Delete] button to remove the network account.
DVR Log File Viewer Function
Select the DVR site name and click the right mouse button. Select the Log file Viewer option on the popup menu.

To View All Entries
Click the date for viewing log on the calendar left.

To View Failed Log Entries
Select the [Fail] tab on the Log information window right, there appears the log information lists.

Viewing Network Log Entries
Select the [Network] tab on the Log information window right, there appears the log information lists.

Viewing Record Log Entries
Select the [Record] tab on the Log information window right, there appears the Record log information lists.

Viewing Normal Log Entries
Select the [Normal] tab on the Log information window right, there appears the normal log information lists.
1-10. Environments Setup
Setting storage devices

Press the button on the right of the program screen, then there appears the environment setting window as shown below.

OSD Setup
Select the OSD setting tab. Then you can specify the use of OSD, the size and color of the OSD font. You can also choose to use the on/off function of the OSD on the screen or not.
The Border Line Setting
Select the border line setting tab; you can choose the use of the border line and color and thickness.

Event Live Popup
The event live popup function is to show the event real time live picture on the popup screen.

1. The Event line popup setting:
The event live popup function is to show the event real time live picture on the popup screen.

2. The application of event live popup:
Set the numbers of the popup windows. When more windows than the specified numbers are used, the popup windows which were first on the screen will disappear.

3. Event setting:
setting events such as stop recording, consecutive recording, movement recording, audio recording, sensor recording, signal, signal loss, and video disconnection.

The date, time, and channel information of the current channel appear on the event live popup window, and the capture function and magnify/contract function are provided.
Screen Setting
Screen setting tab presents the screen output of program.

1. Pixel number and size convert:
   A screen recorded in 720 pixel is converted to 740 pixel.

2. Live screen layout:
The first screen is selected and produced automatically, after
the network connection in the first drive of program.

3. Draw string setting:
   Connecting, signal loss, video disconnected, message font,
   height, bold, and color selecting function.

Alarm Output Setting
When an event happens, an event message output and an alarm output repeatedly appear in the alarm output setting.

1. Power shut off

2. DVR operation failure:
   Backup failure, network link failure, no signal, pan operation
   failure, hardware failure, hard disk failure, codec failure, codec
   recover, signal connection, video connection cancellation,
   video hide, Hotswap add/delete, and hard disk danger.

3. Sound effect:
   You can select the system beep sound or the wave file.

4. Sound duration time:
   Alarm sound can be selected per second.
The event list box outputs an event message, when an event happens.

When a log event happens in the DVR system, there appears the event list windows as shown in the picture. There are alarm type, time, and DVR name in the list. The sound effect is reproduced and continues until the user presses the confirm button.

Backup setting
The backup setting tab saves all the data in backup files or applies saved backup files.

It can save and recover environment setting values.

Load – the saved information in files is applied to the current program.

Save – the current program information is saved in files.
1-11. Video Image Capture

Current screen capture
Press the button on the right of the program. The picture captured by the current monitoring screen appears as shown in the picture below.

Brightness / darkness / saturation / color / gamma adjustment
Brightness/ darkness / saturation / color / gamma values are adjusted by the movement of the slide bar in the right panel control box.

Color adjustment
Color values are adjusted by moving the slide bar in the right panel amount and hue control box.

Filter application
Filter values are adjusted by moving the slide bar in the right panel amount and hue control box.

Original picture recover
Click the [Reset] button in the right panel. Then the original picture is recovered.

Rotation
Click an angle icon in the top icons. Then the picture rotates to the angle.

Left/right reversal
Click the icon in the top menu, or select [Edit] -> [Flip] -> [Horizontal].

Up/down reversal
Click the icon in the top menu, or select [Edit] -> [Flip] -> [Vertical].

Save
To save in the basic folder and file name, click the Save icon in the top menu or select [File] -> [Save].

Print
Click the icon in the top menu, or select [File] -> [Print].
When the print window appears, select the print option and click the [OK] button.
Image print
Click the button on the right of the program screen. The saved image file list window saved by the monitoring screen capture will appear.

Select the image file in the file list window, and click the [Preview]. The preview window appears. Enter a title of print to "title" in the preview window, and an explanation of print to "memo."

Click the [Print] button.

When the print window appears, select a printer and click [OK].
1-12. Adjusting Colors

Click \[\text{button}\] in the program screen. There appears adjust color & post processing window.

Click channel check box in the adjust color & post processing window and select a channel. Drag Brightness, Gamma, Contrast, Saturation, Tint adjust columns and adjust.

Press [Initialization] button and return to the initialization. When color adjustment is completed, press [Close] button.
1-13. Full screen mode

**Full screen view**

Click the 🎧 button in the program screen, and you will have a full screen mode.

To return to the basic mode, click the 🎧 button in the program screen.
1-14. Record Search

Search Recording
Select Search tab on the initial screen of the program. Drag the DVR unit name you want to search from the connected DVR lists on the right and drop it on the monitoring window.

Select Time and Date
The date recorded on the search screen is checked with red color on the edge. Select a date you want. Select the recorded date in the calendar, and then the recorded status on the day will appear from 0 to 23 hour as shown in the picture below.

Select A&V, Video, Audio tabs on the top of the search screen, then the recorded status in audio or video will appear. Select All, Motion, Sensor, Audio tabs, and then the recorded status in the recorded events will be indicated.
Select a search method
   Status Bar  Displays recorded footage by hour/minute in bar graph format
   File List  Displays recorded footage by hour in list mode

Click [Status Bar] or [File List] on the search window and select a search method.

If you change time in DVR system, recording events before time change turn into blue color
1-15. Playback
Specify the time and click the playback button. A playback screen will appear as shown in the picture.

Using the playback control button, regulate the playback speed. Press the playback start button.

Recorded Video Download

In the search mode, drag the time selection line from the search window, and select the time to start download. Select time first, and then decide starting minutes and closing minutes. Click Download.
After selection, press the download button. A download selection window will appear.

![Download Selection Window](image1)

After setting time, select channels to download as shown in the picture below and check.

![Channel Selection](image2)

After setting channels, specify the storage path as shown in the picture below.

![Storage Path](image3)
After completing all settings, press the start button. The saving folder name and the file size for download appear as shown in the picture below.

![File Download](image)

The download file is produced and saves in a folder specified by application and in download starting and ending time. When a download is completed, a message box appears. Click the [OK] button.
1-16. Local Player

Record file search and playback
Select the Local Player on the program initial screen
There appears the initial screen with the folder search window as shown in the picture below.

![Folder Search Window](image1)

Record file search and playback
Search the folder list on the program screen in the local playback mode. Search the folder which has the download or backup record files

![Folder List](image2)

The folder with a recorded file has starting date and time and finishing date and time in its name. Select a backup folder or a folder for download.

![Folder List](image3)

After selecting a folder for playback, click the button, and then the first screen in the selected time appears stand still as shown in the picture below.
Smart search function
To start a smart search, press [Smart Search] in playback or start mode, and then the playback stops.

Select a channel for the smart search and double click. There appears the Grid window in which the zone of the smart search can be specified. Four zones can be selected; they can be specified by dragging the mouse. The sensitivity can be chosen in 5 steps by pressing the right mouse button.

When the smart search starts and there is a movement in the specified zone as shown in the picture below, a screen appears.

When the smart search completes, the times when there are movements in the specified zone are shown in the list. If you click a list, the search moves to the time zone of the list. With double click, the playback of the time zone starts.
1-17. Remote Control setting

Start
Select the program initial screen DVR Setup tab.
Drag DVR IP or Alias Name you want to select from the DVR list and drop it on the monitoring window.

DVR Main/App Setup
Remote DVR setting screen is the same as DVR OSD (on screen display).
Using the mouse on the DVR setting screen, you can change the system setting values.
Click the right button of the mouse in the zone where you want to change the setting values, and then there appear possible setting value ranges. Select a value and change.

In case you should enter a name directly like a channel name, you can change it by double click.
Open
When DVR system is connected, [open] button is non-activated. Apply a setting value by drag & drop.

Save
Modify the setting value on the screen by using the mouse. Click the save button, and then the current setting value is saved (extension * .bin)

![Save dialog box]

Click [save] button and save as a file.

Send
When a remote DVR is connected, a DVR list currently connected in [DVR setting save] will appear.

![DVR setting save dialog box]

Select a DVR you want to modify and click the [send] button.
The modified DVR setting value is applied to the remote DVR. A message window as shown in the picture below appears and the network is disconnected.

![Message window]